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Description 

This class will cover the use of InfraWorks 360 as a bridge modelling and design tool in the context of a 

wider transportation project and explore a workflow to each of Civil 3D, Revit and Autodesk Structural 

Bridge Design. 

You will learn how to create concrete bridges in InfraWorks 360 and use the Line Girder Analysis cloud 

service to quickly validate the girders against different design standards and to establish the required pre-

stressing. You will learn how you can then simply open up the corresponding analytical model directly in 

Autodesk Structural Bridge Design for further refinement as well as to carry out more detailed analysis 

and design checks. 

You will learn how to open up the InfraWorks 360 model in Civil 3D and Revit to enable further design 

and documentation. 

 

About the speaker 

Andrew Manze is Autodesk’s InfraWorks 360 Business Development Manager in EMEA. He has 
worked in the civil and structural engineering industry for over 30 years functioning both in 
industry and in the specialist construction software sector. After training as a structural engineer 
in the UK in the late 80’s and working on a variety of unusual and novel international projects 
Andrew moved on to business development in the 3D modelling and structural analysis software 
field spending many years bringing innovative technology to the European and CIS regions. In 
later years Andrew has concentrated on the bridge analysis and design market getting involved 
with the rollout of the Eurocodes within engineering consultants in Europe. 

 
 

 

Learning Objectives 

 Identify workable bridge design at early project stage 

 Produce structural calculations for concrete bridge beams 

 Quickly model bridge structures in the context of a project landscape 

 Connect bridge models to Civil 3D and Revit to enable further detailing an 
documentation 
 



Hands-on Tutorial for Bridge Design in InfraWorks 360  
 

In this tutorial we will be utilizing an existing InfraWorks 360 model and modelling from scratch a 
new bridge proposal. The input for generating most of the bridge will be conceptual in style and 
so some flexibility in modelling is to be expected and encouraged. 
 
The bridge that we will be modelling is to cross a dual carriageway linking the existing road 
networks on either side. 
 
Once the initial bridge has been modelled we will explore ways of analyzing and designing the 
prestressed concrete bridge girders. 
 
Once we have examined the structural calculations we will link the bridge model and 
surrounding topography to Civil 3D and finally export the bridge model to Revit. 
 
1. Once logged in to InfraWorks 360, from the Home Screen OPEN the model AU Bridge 

Modeling Lab 
2. From the utility bar at the top of the screen click on master and add a new proposal 

called NewBridge 
3. Again from the utility bar click on the bookmarks icon and use the Bridge bookmark 
4. Your model should look like this; 
 
 

 
 
 
 
 
 
 



5. Rotate the view so that we are looking on plan and zoom out as shown below. We will 
be tying into the road network on each side of the cutting. 

 

 
 

6. From the Design Roads menu select Component Roads and then Two Lane Road 
gutter and pavement from the assembly list. 

7. Create a road alignment as shown below tying in the two road networks across the 
cutting. 
 

 



8. Rotate the model to a side view and right click on the road then select Show profile 
view. 

9. Use the profile view to achieve a vertical alignment similar to that shown below. Use the 
right click menu to add and remove PVIs as necessary. Close the profile view when 
complete. 

 

 
 
10. Right click on the road and select Add Bridge, click on the road on the left side of the 

cutting and then the right to specify the extent of the bridge. 
 

 



11. The bridge modelled should look similar to that below. Ensure that the bridge has at 
least 4 or 5 piers. 

 

 
 

12. BREAK. 
13. Click on the main carriageway so that the full width of the carriageway is selected, then 

right click and select Replace Assembly from the menu. 
14. Select a starting position for the bridge road profile and then click on the black grip to 

extend the profile to the other end of the bridge and release. 
 

 



15. Select from the Component menu Lane Bridge with Red Rail Pavement and press 
return. 

16. The bridge should then be modelled as below; 
 

 
 
17. Select the main central pier and then click Legacy Pier in the contextual stack on the 

right 
18. Double click Standard Pier 3 in the list to change the pier type as below; 
 

 
 



 
 

19. With the pier selected make the following changes to the pier geometry in the contextual 
stack on the right. 

a. Columns = 3 
b. Width: Front = 1.5m 
c. Width: Back = 1.5m 
d. Depth 2m 

 

 
 
 



20. Right click on the selected pier and pick Apply to…All Piers 
 

 
 
21. Select from the utility bar Engineering View 
 

 
 
22. Select the pier foundation and make the following changes to the foundation geometry in 

the contextual stack. 
a. Type = Rounded Pile Cap 
b. Count: Longitudinal row = 2 
c. Spacing ratio: Longitudinal = 6.0 
 



 
 

23. Right click on the selected foundation and choose Apply To…All Pier Foundations 
 

 
 
 

24. Now reposition the central pier between the two carriageways. Click on the pier, ensure 
it is selected, then use the purple grip over the pier to move it. Then use the orange 
rotation grips to rotate the pier into position. Make note of the skew angle in the 
contextual stack. 

25. Click on each pier in turn and apply the same skew angle. 



26. Move each pier in turn to achieve an even distribution across the bridge 
 

 
 
 
27. Select the abutment for the left hand side of the bridge. Make the following changes in 

the contextual stack. 
a. Type = Wing Walls 1 
b. Offset = 8m 
c. Depth: Left = 12 
d. Depth: Middle = 12 
e. Depth: Right = 12 
f. Legnth: Left = 9 
g. Length: Right = 9 
 
Results may vary with this numbers, try adjusting the values to create an abutment that ‘looks 
right’. If necessary move the extent of the bridge deck by selecting the bridge deck and 
redefining the bridge length/station. 



 
 

28. Repeat for the other abutment. 
29. BREAK 
30. Click on the bridge deck, right click and tick Show Superelevation, repeat and tick 

Show Cross Section View. Drag the Yellow section marker to examine the 
Superelevation, then repeat and untick Superelevation and close the cross section 
window. 

 

 
 



31. Select the bridge deck, change these values; 
a. Left edge to curb = 1.5m 
b. Right edge to curb = 1.5m 
c. Continuity = Deck Only 
 
The bridge girders should now be ‘discontinuous’. 
 

 
 
Notice the values in the contextual stack relating to Concrete strength and Superimposed 
loading, these will be used shortly with the structural analysis and design functions. 
 
32. By selecting the bridge and looking to the contextual stack, click on the Design Standard 

dropdown menu to reveal the available design standards for bridge analysis and design, 
leave as AASHTO LRFD. 



 
 
 

33. Select and then right click on a bridge girder. Expand the Component Display menu and 
untick Road and Deck. 

 

 
 

34. Click on the Section Type External to reveal the bridge girder Select Component list, 
double click AASHTO Type VI to change section type. 

35. Repeat for Internal girders. 
36. Right click on the selected group and select Apply To…All Girder Groups. 



37. Examine the values in the contextual stack for Material Properties, these will be used 
next in the girder design. 

38. BREAK 
39. From the Bridge menu, select Line Girder Analysis. 
 

 
 
40. Click the Project information…link and change some of the data and close. 



 
 

41. Change the Job number to 100 and untick Consider harped tendons. 
42. Click Start Analysis (if time is short do not start the analysis but switch to the proposal 

LineGirderAnalysis_1 where the results for a similar bridge are already stored and 
activate the line girder analysis function) 

43. Once the analysis and design are complete hover over the color coded girders to inspect 
the unity factors. 

44. Select one of the girders to reveal more unity factors in the Line Girder Analysis panel 
with the leading design case highlighted in orange. 



 
 
45. Click Get Full Report, Complete Purchase and examine results. 
 

 
 
46. To open the structure in Autodesk Structural Bridge Design 2017 click the open icon. 
 



 
 

47. Click Done is the main ASBD screen. Then select Design Beams from the side menu 
and then click SB1: Pre-tensioned Prestressed. 

 

 
 



48. By selecting different items with in the tree we can examine different analysis results for 
beams within the selected structure in both graphical and numerical form. 

 

 
 
49. Moving down to Structure Loads Menu item we can examine the various loadings that 

were generated by InfraWorks 360. 
 

 



50. By selecting Beam Definition and then Tendons from the Pre-tensioned Beam 
Definition dialogue we can interact with the tendon design and make changes where 
necessary. 

 

 
 

 
 



51. To test any changes or to examine the existing results we can click the Analyze beam 
play button. 

 

 
 
52. You will then be presented with the Analysis screen, where we can interact with the 

girder design, below is a stress plot of the compressive stresses in the concrete girder 
for permissible and design stresses in the top and bottom of the beam. 

 

 
 
53. Click and hold the pink section line and drag to a point of interest anywhere along the 

beam. Then hit Results… and then PDF View on the bottom tab. 
 



 
 

54. You will see that we are presented with similar results to that obtained from with 
InfraWorks 360, but reflecting any changes made. 

 

 
 

55. Close down Autodesk Structural Bridge Design clicking Yes to Okay to lose edits? 
56. Back in InfraWorks 360 click Line Girder Analysis from the menu to close that function. 



57. Close InfraWorks 360. 
58. Start Autodesk Civil 3D Metric. 
59. Ensure that you are working in the Civil 3D Workspace and select Open InfraWorks 360 

Model from the Insert tab. 
 

 
 
60. Navigate to the InfraWorks 360 model folder and select AU Bridge Modeling Lab.sqlite 
61. Select Set a Coordinate System and choose Use the InfraWorks 360 model 

coordinate system [BritishNatGrid]. 
62. Then under Selection Area choose Area of Interest and then Select Area… 
63. Civil 3D will then load the InfraWorks model extents with a map overlay. Select a 

window similar to the one shown to encompass the bridge project. 
 



 
 

64. In the Open InfraWorks 360 Model dialogue Open the Object setting configuration. 
 

 
 



65. Examine the exchange settings, no changes necessary. 
66. Click Refine Selection Set… 
67. Use the controls at the top of the dialogue to deselect all items in the tree. 
 

 
 
68. Then click to add 
a. All Terrain Surfaces 
b. All Design Roads 
c. All Coverages (Terrain Modifying) 
d. All Bridges 
69. Then click OK. 
70. Then click Open Model. 
71. The selected InfraWorks 360 model entities will then be opened in Civil 3D. 
 

 
 
72. Click Map Hybrid from the ribbon and select Map Off. 
 



 
 

73. Zoom in with the mouse to examine the imported bridge and surfaces. 
 

 
 

74. From the View tab select Shaded view. 
 



 
 
75. Use shift – middle mouse button to rotate the view, examine the model. 
 

 
 
76. Close Civil 3D. 
77. Restart InfraWorks 360 and load our AU Bridge Modeling Lab model. 
78. Choose the Bridge bookmark from earlier. 
79. Ensure that the NewBridge proposal is current in the utility bar. 
80. The previously modelled bridge should now be visible, rotate it to a convenient view. 
 



 
 

81. Select the bridge and then right click and select Quantities… 
 

 
 

82. Once the Quantities panel has opened click around the model selecting different parts, 
the Selected row in the Quantities panel will change accordingly. 

 



 
 
83. Close the Quantities panel. 
84. Deselect the bridge by clicking somewhere in the terrain. 
85. Reselect the bridge and right click. 
86. From the right click menu choose Send to Revit. 
 

 
 
87. The Revit entities will be created and the Revit window will open. 
88. Once the Revit window has opened, from the View tab select 3D view. The wireframe 

bridge model should appear. 



89. From the bottom of the screen select a display option. 
 

 
 

90. Zoom in (mouse wheel) and rotate the view (shift-middle button) to examine the Revit 
bridge model. 

 



 
 
91. This ends the tutorial. 
 
Summary 
The InfraWorks 360 bridge modelling tools can be used to rapidly model realistic conceptual 
concrete bridge structures in the context of the project environment. Bridge components 
automatically sized by the heuristic rules can be adjusted. 
 
The integrated Line Girder Analysis and Design can produce designs for the modelled girders 
and allow the designer to quickly arrive at a workable girder solution that can be modified and 
verified with the Autodesk structural Bridge Design workflow. 
 
Representative quantities can be obtained which can be used to assist in early budgeting. 
 
Workflows to both Civil 3D and Revit allows for the use of InfraWorks 360 modeling data further 
down the design journey of the bridge structure allowing changes to the surrounding grading, 
production of sheet sets, structural drawings and rebar detailing. 


